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Overview

Introduction Symposium WebResponse Server is part of the Nortel (Northern
Telecom) suite of applications. The Symposium WebResponse
Server Installation and Integration Guide provides instructions
and information for installing, configuring, and using Release
1.0 of the Symposium WebResponse Server software.

Intended audience

Users of this guide This guide is for system administrators and technical support
personnel who are responsible for installing and configuring
Symposium WebResponse Server.

It is assumed that the user has experience with computers,
telephony products, databases, the Internet, Windows NT and
Windows 95. Maintenance of this product is to be performed by
qualified information systems personnel only.

Agents and supervisors using Symposium WebResponse Server
should refer to the online help and tutorials provided with the
Administration and Agent components of this product.

Conventions

Introduction Conventions used in this guide have been established to help
you learn how to use the program quickly and easily.

Sample conventions Any information entered into the system, such as keys that you
press or on-screen buttons and icons that you click with the
mouse, are shown in bold as follows:

Type d:\setup, and press Enter or click OK .

Messages that are on-screen appear in a special font:

Are you sure?

Note: is a paragraph with additional information that will help
you to understand the program and the relevant steps better.

ATTENTION
Boxed text contains additional information that is essential

for successful completion of the relevant task.
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Organization of this guide

Introduction The Symposium WebResponse Server Installation and
Integration Guide contains five chapters and an appendix. Each
section is briefly described below.

Chapter 1
Getting started

Chapter 1 includes an introduction and description of
Symposium WebResponse Server. It describes minimum system
requirements for installing Symposium WebResponse Server.

Chapter 2
Installation

Chapter 2 includes a pre-installation checklist and instructions
for installing Symposium WebResponse Server and Sybase
Adaptive Server Enterprise.

Chapter 3
Configuring Symposium
WebResponse Server

Chapter 3 describes how to run Symposium WebResponse
Server, access online help and tutorials, create database labels,
and create skillsets.

Chapter 4
Symposium WebResponse
Server database

Chapter 4 provides a list of the Symposium WebResponse
Server database tables and fields and describes how to share
information with other databases.

Chapter 5
Database integration

Chapter 5 provides information on integrating external databases
and softphone applications with Symposium WebResponse
Server through Dynamic Data Exchange (DDE).

Appendix A
Troubleshooting

Appendix A provides information about possible error
conditions in Symposium WebResponse Server and how to
respond to them.
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Related documents

Introduction The following documents may be useful sources of information
when you are working with this guide:

� MS-Windows User’s Guide (available from Microsoft
Corporation)

� Telephony User’s Guide (available from Microsoft
Corporation)

� Sybase System 11 Documentation (available at
http://sybooks.sybase.com/cgi-bin/nph-dynaweb)

� Nortel Symposium Desktop TAPI Service Provider
Implementation Planning Guide and User’s Guide
(see your Nortel distributor for web page location)

� Nortel Symposium Call Center Server suite of
documentation, available from Nortel
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 Chapter 1 Getting started

 In this chapter

 Overview....................................................................................................2
 System requirements ................................................................................5
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 Overview

 Introduction  Welcome to Nortel’s Symposium WebResponse Server
application, Release 1.0.

 Symposium WebResponse Server is a client/server call center
application that expands call center e-mail capabilities to allow
agents to view, respond to, and track requests from the Internet.
Unlike conventional e-mail requests to a single e-mail account,
Symposium WebResponse Server not only lists all requests, but
records all responses with the initial request. This allows the call
center to control and measure the volume of traffic from the
Internet. Supervisors and administrators can view both real-time
displays of call center activities as well as run historical reports.

 Symposium WebResponse Server includes four components:

� an agent component, installed on each agent’s PC, that
agents use to view and respond to requests from the web
page

� an administrator component, installed on the database server
or on a separate Windows NT or 95 workstation, that
provides administrative and management capabilities

� a web component, set up on the web server, that receives the
requests from a standard HTML form

� a database component (Sybase), installed on the database
server, that tracks all call center activity

 Symposium WebResponse Server administrators are generally
responsible for configuring the database and web components.
The following diagram provides a graphical representation of
the flow of transactions when using Symposium WebResponse
Server.

 



 
 Getting started 3
 
 
 

Standard 1.0 Symposium WebResponse Server June 1998
Installation and Integration Guide

 

Symposium WebResponse Server

Internet
WWW

PSTN

Customer web form
• enters contact info
• qualifies interests
• chooses e-mail or call-back
• uses free text field for detail

Symposium WebResponse – Agent
• selects transactions
• previews customer information
• acts on request
• e-mails with MAPI-compliant application
• calls back with TAPI & softphone application
• interfaces to other databases

Symposium WebResponse Server
• captures and stores requests
• categorizes by source page and web form data
• manages agent logins and skillset profiles
• performs database administration

Web server
• hosts HTML forms
• serves up Java applets/optional
• has “Entrust-ready” security

1

3

4

Symposium WebResponse –  Administration
• views real-time call center activity
• views pending requests
• administers agent and skillset data
• views and files historical reports

5

2

 1    Customer web form  Customers send requests to the Internet call center by
completing the web form created by the administrator.

 2    Web server  Using either the Java or the HTML generator supplied with the
web server, the administrator creates the web form that
customers use, then customizes this form using any HTML
editor or Java compiler. For more information, see the online
help for Symposium WebResponse – Administration.

 3    Symposium
WebResponse Server

 Symposium WebResponse Server uses a Sybase database to
store all information required by the system. This includes
customer data, agent information, and call statistics. The
database must be populated after Symposium WebResponse
Server is installed. For more information, see “Creating database
labels” on page 33.
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 4 Symposium
WebResponse – Agent

 Agents access Internet-generated customer requests from
Symposium WebResponse – Agent. Once they log on, agents
can view all calls received for their designated skillsets, generate
e-mail or telephone responses to customers, update customer
transaction records, and check the real-time status of requests.
For more information, see the online help and online tutorials
included with Symposium WebResponse – Agent.

 5 Symposium
WebResponse –
Administration

 The Administration component is used to administer and
manage the call center. The Administrator adds and configures
users, defines skillsets and thresholds, runs reports, and views
real-time information about call center activity. The
Administrator also generates the web form and defines the
interface for the Agent component. For more information, see
the online help and online tutorials included with Symposium
WebResponse – Administration.
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 System requirements

 Introduction  The following list details the minimum system requirements to
successfully run Symposium WebResponse Server. For
information on Sybase, TAPI, and messaging systems, refer to
the appropriate documentation.

 Minimum agent computer
hardware requirements

� Pentium 100 or greater personal computer

� 16 Mbytes of RAM

� 100 Mbytes of free disk space

� LAN connection

� 14 in. monitor with at least 640 x 480 resolution

� one of the following telephones may be required, if using
some softphone applications: M2008, M2216, M2616; or
MDT3110, MDT310, MDT3820

� MCA adapter or Communicator Card may be required, if
using some softphone applications

 Minimum agent computer
software requirements

� Windows 95 or Windows NT 4.0

� TCP/IP protocol

� Sybase Open Client (supplied on CD-ROM)

� Microsoft ODBC Manager (supplied on CD-ROM)

� MAPI-compliant e-mail application (Microsoft Exchange
4.0 recommended)

� Symposium FastView or other softphone application, if
required for your call center

� Microsoft TAPI 2.1, if using a softphone application

� Nortel TAPI Service Provider version 1.0, if using a
softphone application

 Minimum administrator
computer hardware
requirements

� Pentium 100 or greater personal computer

� 16 Mbytes of RAM

� 100 Mbytes of free disk space

� LAN connection

� 14 in. monitor with at least 640 x 480 resolution



 
 Getting started 6
 
 
 

Standard 1.0 Symposium WebResponse Server June 1998
Installation and Integration Guide

 Minimum administrator
computer software
requirements

� Windows 95 or Windows NT 4.0 with Service Pack 3.0

� TCP/IP protocol

� Sybase Open Client (supplied on CD-ROM)

� Microsoft ODBC Manager (supplied on CD-ROM)

� Java compiler (if using a Java applet)

 Minimum web server
hardware requirements

� Pentium 166 or greater personal computer

� 48 Mbytes of RAM

� 2 Gbytes of free disk space

� 14 in. monitor with at least 640 x 480 resolution

� LAN connection

 Minimum web server
software requirements

� Windows 95 or Windows NT 4.0

� TCP/IP protocol

� web browser (Microsoft Internet Explorer version 4.0 or
Netscape Navigator version 4.0 recommended)

� web server, for example Microsoft Internet Information
Server

 Minimum database server
hardware requirements

� Pentium 166 or greater personal computer

� 48 Mbytes of RAM

� 2 Gbytes of free disk space

� additional disk space will be required for database as
information is added

� LAN connection

� 14 in. monitor with at least 640 x 480 resolution

� CD-ROM drive

� a modem is required if you are using pcANYWHERE32

 Minimum database server
software requirements

� Windows NT 4.0 with Service Pack 3.0

� TCP/IP protocol

� Sybase Adaptive Server Enterprise (Sybase version 11.5,
supplied on CD-ROM)

� Microsoft ODBC drivers (supplied on CD-ROM)

� pcANYWHERE32 is required if your organization has
purchased Nortel external support services.
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 Chapter 2 Installation

 In this chapter

Overview....................................................................................................8
Pre-installation checklist............................................................................9
Installation overview ................................................................................10
Installing Sybase Adaptive Server Enterprise .........................................11
Installing the Main Installer ......................................................................14
Installing the Database Generator...........................................................17
Generating the Symposium WebResponse Server database ................18
Installing the Real-Time Server ...............................................................20
Installing the Web Server Socket ............................................................21
Installing Open Client and the ODBC manager and drivers....................22
Installing Symposium WebResponse – Administration...........................24
Installing Symposium WebResponse – Agent ........................................26
Uninstalling Symposium WebResponse Server......................................28
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 Overview

 Introduction  This chapter gives you a pre-installation checklist and guides
you through the installation of the Symposium WebResponse
Server applications. Instructions for uninstalling Symposium
WebResponse Server applications are included as well.
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 Pre-installation checklist

 Introduction  Before installing Symposium WebResponse Server (SWRS),
check that your system is set up according to the requirements
listed in Chapter 1, “Getting started.”

 Pre-installation checklist

 

� Refer to the README.TXT file on your Symposium
WebResponse Server CD. This file contains information
that was not available when this guide was printed. Read
this information before installing Symposium WebResponse
Server.

� Check that your system hardware and software meet the
minimum requirements for use with Symposium
WebResponse Server. For details, refer to “System
Requirements” on page 5.

� Check that the Meridian 1 switch is programmed for use
with the telephone using Symposium WebResponse Server

� Check that the TAPI Service Provider is installed and
configured for use with Symposium WebResponse Server.
For details, refer to your TAPI documentation.

� Check that TAPI and the softphone application, if required,
are installed and operational. During installation, you will
require the IP addresses of the database server and the web
server. A vacant CGI and RT Server port are also required.

� Check that a MAPI-compliant E-mail application is installed
on the agent desktops.

� Check that you have details of your DDE server if you are
using the Dynamic Data Exchange features.
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Installation overview

Introduction You install Symposium WebResponse Server using the setup
utilities on the CD. Each portion of Symposium WebResponse
Server has an installation program and must be installed
separately on the appropriate machine.

Note:  Read the information in the README.TXT file on the
Symposium WebResponse Server CD before installation.

Main installation
procedures

These are the main procedures required to install Symposium
WebResponse Server. Each procedure is described in detail later
in this chapter.

1 Install the Sybase Adaptive Server Enterprise (Sybase 11.5)
database on the database server machine. You must name
the Symposium WebResponse Server database IRMSRV.

2 Install the Main Symposium WebResponse Server
application to install Symposium WebResponse Server to
the database server from the CD.

3 Install the Database Generator.

4 Generate the Sybase SQL Database by running the DB
Generator.

5 Install the Real-Time Server on the database server.

6 Install the Web Server Socket on the Web Server.

7 Ensure that the Sybase Open Client and Microsoft ODBC
drivers are installed on each agent’s PC.

8 Install Symposium WebResponse – Administration from the
server onto the server machine or separate Windows NT or
95 workstation.

9 Install Symposium WebResponse – Agent from the server
onto an agent PC.

Note: If your organization has purchased Nortel external support
services, install pcANYWHERE32 on the database server and
connect a recommended modem to the database server. Consult
your Nortel representative for information.

After installation is complete you are ready to configure the
Symposium WebResponse Server software to reflect your call
center’s specific requirements. See Chapters 3, 4, and 5 for
configuration information.
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Installing Sybase Adaptive Server Enterprise

Introduction To install Symposium WebResponse Server, you first install and
configure the Sybase database and the Sybase Adaptive Server
Enterprise (Sybase 11.5). The database application is included
on your Symposium WebResponse Server CD. If you do not
have the Sybase 11.5 database installed, you will not be able to
install Symposium WebResponse Server.

You install Sybase Adaptive Server Enterprise (Sybase SQL
Server database) using the Sybase installation program included
on the Symposium WebResponse Server CD. This installation
process supports only a fresh installation of Sybase Adaptive
Server Enterprise with Symposium WebResponse Server as the
only database.

Note:  When configuring the database, the Symposium
WebResponse Server setup procedure uses the sa account with
no password. Do not change or remove the sa account.

To install Sybase Adaptive
Server Enterprise

The following is a step-by-step guide to the database installation
procedure. Except for the server name, you can accept the
default settings.

1 Insert the SWRS CD into the CD-ROM drive.

2 Click the Start  button  on the Windows taskbar and
select Run .

3 In the Open box in the Run dialog box, type
d:\sybase11_5\setup  where d: is the CD-ROM drive.

4 Click OK.
The Sybase Installation Utility program guides you through
the installation process. Follow the instructions on the
screen.

5 On the Welcome screen, click Next .

6 On the Select Installation Type window, make sure Licensed
Products is selected and then click Next .

7 On the Select Sybase Installation Directory window, type the
drive and directory for the Sybase installation, for example
c:\Sybase , then click Next .

8 On the Select Program Folder window, specify the program
folder for your Sybase products, for example Sybase , then
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click Next .

9 On the Product Selection window, make sure that Adaptive
Server Enterprise, Sybase Central, Open Client, and ODBC
Driver are checked, then click Next . Other products and
components are optional but may prove useful if you have
space on your disk drive.

10 On the Installation Summary window, confirm the installation
settings and then click Install .

11 On the SQL.INI dialog box, make sure the Ignore for now
option button is selected and click OK. (Changes to SQL.INI
are part of the SWRS installation.)

12 On the Create an Adaptive Server dialog box, in Adaptive
Server, type IRMSRV, then click Create .

 Important
SWRS works only when the server is named IRMSRV. If
the Sybase installation is allowed to default to the
machine name, SWRS will not work.

13 Check your watch. On a low-end server, the installation of
the database may take up to 15 minutes. Be patient before
you assume that the setup routine is not responding.

14 On the Installation Complete dialog box, select I will reboot
my machine later, and then click Finish.

15 From the Services dialog box (Start>Settings>Control
Panel>Services) set the Startup type to Automatic for:

Sybase SQLServer_IRMSRV
and
Sybase BCKServer_IRMSRV_BS

16 Reboot the database server and log back in to Windows NT
using administrator privileges. Rebooting ensures that the
required services are started before the database
generation.
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To start Sybase Adaptive
Server

Sybase Adaptive Server must be running for a successful
installation of Symposium WebResponse Server.

1 Click the Start  button  on the Windows taskbar and
select Programs>Sybase>Sybase Central . The IRMSRV
database server should have started automatically when you
rebooted. Check to make sure it did restart.

2 In Sybase Central, make sure that the status icon  next to
IRMSRV is green. If the status icon is red, consult the
Sybase Central online Help topic "To start Adaptive Server
Enterprise". Note that the default User ID at this point is sa
(use lower-case letters) and there is no password (leave
blank).

3 Exit Sybase Central.
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Installing the Main Installer

Introduction The main (primary) installation performs the following actions:

� installs and configures the software files for the Database
Server

� copies the secondary installers from the CD to the Database
Server

� generates and distributes the initialization files for the
Secondary Installer

 During the installation you will need to know the:

� IP address of the web server

� IP address of the database server

� unused CGI port number of the database server (for
example, 5005)

� unused Real-Time port number (RT) of the database server
(for example, 9000)

Note: If you intend to use the Dynamic Data Exchange (DDE)
feature of Symposium WebResponse – Agent, you need to know
details of your DDE server application. See “DDE messages” on
page 48 for more information.
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To install Symposium
WebResponse Server on the
database server

1 Log in to the database server with Windows NT
Administrator privileges.

2 Insert the Nortel Symposium WebResponse Server CD into
the CD drive.

3 Click the Start  button  on the Windows taskbar and
select Run .

4 In the Open box in the Run dialog box, type d:\setup  where
d: is the CD-ROM drive, then click OK.

5 On the Welcome window, click Next .

6 On the Software License Agreement window, confirm that
you accept the license by clicking Yes.

7 On the Installation Information window, review the text, then
click Next .

8 On the Select Log Directory Location window, confirm the
location, then click Next .

9 On the Select Components window, select Install/Upgrade
and then click Next .

10 On the Choose Destinations Location window, click Next .

By default the Primary Installation creates and places all files
in the \Nortel directory on the c: drive. You can specify a
different directory if required.

11 On the Select Program Folder window, click Next .

12 On the Connection Information dialog box, in the SWRS box,
type the Symposium WebResponse Server IP address, CGI
port number, and real-time (RT) port number. These should
be separated by commas and no spaces.

13 In the Web box, type the IP address of the web server and
then click Next .

When installation is complete, a message indicating that the
primary (Main) installation is complete will appear. Click
Finish.
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To edit the Agent
configuration file for
Dynamic Data Exchange
applications

If you are using the Dynamic Data Exchange (DDE) feature of
Symposium WebResponse – Agent you will save time by editing
the master copy of the Agent initialization (INI) file now.

By editing the master copy now, the configuration will become
part of each installation. In this way, you won’t have to edit each
agent’s file individually.

1 Obtain the details of your DDE server. Refer to “DDE
messages” on page 48 for more information.

2 On the database server, in the c:\Nortel\Agent\Agent Installer
directory, open IRMCLIENT.INI in Notepad.

Note : An unedited version of IRMCLIENT.INI is stored in
c:\Nortel\INIFiles\.

3 Make the required changes to the DDE sections.

4 Save your changes and exit.
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Installing the Database Generator

Introduction Before you can create the Symposium WebResponse Server
database, you must install the Database Generator on the
database server.

To install the Symposium
WebResponse Server
Database Generator

1 Log in to the database server with Windows NT
Administrator privileges if you have not already done so.

2 Click the Start  button  on the Windows taskbar and
select Run .

3 In the Open box in the Run dialog box, type (including the
quotation marks) "c:\nortel\database\DB installer\setup"
where C: is the hard drive.

4 Click OK.

5 The setup program guides you through the installation
process. Follow the instructions on the screen.

When installation is complete, a message indicating that the
installation is complete will appear.
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Generating the Symposium WebResponse Server database

Introduction You must generate the database that will be used with
Symposium WebResponse Server. This process uses the
Database Generator and Sybase SQL Server.

Note:  To check that the database has been created, a factory
default user ID (usually sa) and password (usually blank) are
required as you enter Database Central. The SWRS database
generation scripts change the database user ID and password
from the default to the following:

User ID: admin
Password: adminpwd
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To generate the Symposium
WebResponse Server
database

1 If you have not already done so, start the Sybase SQL server
by referring to the Sybase online help.

2 Click the Start  button  on the Windows taskbar and
select Programs>Nortel>Symposium WebResponse DB
Generator>Symposium WebResponse DB Generator .

3 In the Symposium WebResponse – DB Generator dialog
box, in the Sybase bin directory box, browse to your Sybase
bin directory, for example c:\sybase\bin .

4 In the SQL Server Name box, make sure the name is
IRMSRV.

5 Click Continue .

6 In the Choose Database Devices Physical Location dialog
box, choose where you would like to store your data for
Symposium WebResponse Server, usually c:\Sybase\data .

7 Click Update .

8 Click OK in the confirmation message box to continue.

9 In the Site details dialog box, in the Company name box,
type the name of your company (for example Letronix
Service).

10 In the Max number of clients dialog box, type the number of
user licenses your company has purchased. You can find
this number on a sticker on the back of the CD case.

Note : Users include agents, supervisors, and administrators.

11 Click Update  and then click OK to confirm the database
insertion details.

12 In the Choose a Backup Physical Location dialog box,
choose where you would like to store your backup data for
Symposium WebResponse Server.

13 Click Update  and then click Yes to confirm that you want to
start the SQL scripts. The SQL Scripts screen shows the
progress of the database generation scripts.

Note:  You must have Sybase SQL Server running before
running the scripts.

14 Click Yes on the confirmation message box to continue.
Wait while the database generates. This can take two or
three minutes. Click OK when the script is finished.
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Installing the Real-Time Server

Introduction The Real-Time Server installation sets up an NT service on the
database server. This service allows Symposium WebResponse
Server to track agent and transaction activity in the call center
and provides input for the real-time displays.

To install the Real-Time
Server for Symposium
WebResponse Server
database

1 Log in to the database server with Windows NT
Administrator privileges if you have not already done so.

2 Click the Start  button  on the Windows taskbar and
select Run .

3 In the Open box in the Run dialog box, type (including the
quotation marks) "c:\nortel\SWRS\RT Server –
installer\setup"  where c: is the hard drive.

4 Click OK.

5 The setup program guides you through the installation
process. Follow the instructions on the screen.

6 After the installation is complete, reboot your system in order
to start this service.
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Installing the Web Server Socket

Introduction You must install the Web Server Socket on the web server. This
allows the web server to communicate with the Symposium
WebResponse Server database server.

To install the Web Server
Socket for the Symposium
WebResponse Server
Database

1 Log in to the Web server with Windows NT Administrator
privileges if you have not already done so.

2 If you have not already done so, create a directory and virtual
directory on your web server with permissions to execute
CGI scripts.  (For example, for Internet Information Server,
create the physical directory c:\inetpub\wwwroot\cgi and
designate it as the virtual directory /cgi.)

3 From the web server, map the database machine and Nortel
folder as a virtual drive.

4 Click the Start  button  on the Windows taskbar and
select Run .

5 In the Open box in the Run dialog box, type
f:\Nortel\Web\Installer\setup  where f: is the mapped drive.

6 Click OK.

7 Follow the instructions as the setup program guides you
through the installation process. When prompted where to
install the CGI script files, enter the destination folder that
was discussed in Step 2.

Note:  The web socket initialization file, IRMWebServer.ini is
copied into c:\WINNT\, not your CGI scripts folder.

8 Make sure your web page forms submit their posted data to
SWRSS.EXE as in the following HTML excerpt:

<form action="/cgi/swrss.exe" method="POST">
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Installing Open Client and the ODBC manager and drivers

Introduction You must install Sybase Open Client and the ODBC manager
and drivers before you can install Symposium WebResponse –
Administration and Symposium WebResponse – Agent.

Note:  If your administrator or agent component runs on the
same machine as the database server, you can skip this
procedure because the required components were installed
during the database server setup.

To install Sybase Open
Client and ODBC manager
and drivers

Install Open Client and the Sybase ODBC manager and drivers
using the Sybase installation program included on the
Symposium WebResponse Server CD.

1 Insert the SWRS CD into the CD-ROM drive.

2 Click the Start  button  on the Windows taskbar and
select Run .

3 In the Open box in the Run dialog box, type
d:\sybase11_5\setup  where d: is the CD-ROM drive.

4 Click OK. The Sybase Installation Utility program guides you
through the installation process.

5 On the Welcome screen, click Next .

6 On the Select Installation Type window, make sure Licensed
Products is selected and then click Next .

7 On the Select Sybase Installation Directory window, type the
drive and directory for the Sybase installation (for example,
c:\Sybase ) and click Next .

8 On the Select Program Folder window, specify the program
folder for your Sybase products (for example, Sybase ) and
click Next .

9 On the Product Selection window, make sure Open Client
and ODBC Driver are checked and click Next .

10 On the Installation Summary window, confirm the installation
settings and then click Install .

11 When prompted to edit your autoexec.bat file, click OK.

12 In the SQL.INI dialog box, make sure the Ignore for now
option button is selected and click OK. Changes to SQL.INI
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are part of the SWRS installation.

13 When prompted, reboot the computer and log back in to
Windows.
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Installing Symposium WebResponse – Administration

Introduction The next step is to install the Symposium WebResponse –
Administration component. Once this is installed, you will be
able to test the installation. Install this component on the
administrator’s PC from the database server where the primary
install was done, because the Administration component uses
initialization files that were generated during the primary
installation. You can install the Administration component on
the same machine that runs the database server or another PC.

Note: The administrator’s PC must have Sybase Open Client
and Microsoft ODBC Manager installed and configured before
you begin installation.
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To install Symposium
WebResponse –
Administration

1 Log in to the administrator’s PC.

If the administrator’s PC is different from the database server
where the primary installation resides, you will need to map a
drive on the administrator’s PC to the database server
machine.

2 Click the Start  button  on the Windows taskbar and
select Run .

3 In the Open box in the Run dialog box, type the following
(including the quotation marks) "c:\nortel\admin\admin
installer\setup"  where c: is the hard drive of the database
server machine, then click OK.

4 On the Welcome window, click Next .

5 On the Choose Destination Location window, confirm the
destination folder and click Next .

6 On the Setup Type window, choose one of the setup
options–Typical,  Compact,  or Custom , and click Next  to
allow the installation to proceed.

7 Wait for a message to appear that installation is complete.
Click Finish .

8 Once this installation is complete, restart the administrator's
computer. Restarting the computer ensures that all services
are started.

9 Log on to the administrator's computer and check the
Windows Programs menu to see that Symposium
WebResponse Admin has been installed in the Nortel
program group.

10 Refer to the online help topic Completing the setup of
Symposium WebResponse Server to configure and
customize your installation. Click
Start>Programs>Nortel>Symposium WebResponse
Admin>Help Files .
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Installing Symposium WebResponse – Agent

Introduction Each agent must have a copy of Symposium WebResponse –
Agent installed on his or her PC. Before installing Symposium
WebResponse – Agent, make sure you have completed these
tasks:

� Ensure that the agent’s PC has Sybase Open Client
(supplied) and Microsoft ODBC Manager (supplied)
installed and configured.

� Share the folder where the primary installation is installed.

� Map the database machine and Nortel folder as a virtual
drive.

� If you are using Symposium WebResponse – Agent to pass
data to a third-party application, you must edit the DDE
information in IRMCLIENT.INI.
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To install Symposium
WebResponse – Agent

1 On the database server, from Windows Explorer, click the
Nortel  folder.

2 From the File menu, click Properties .

3 Click the Sharing  tab.

4 On the Sharing property page, click Shared As .

5 Type Nortel  in the Shared Name box.

6 Click OK.

7 Go to the agent’s PC on which you want to install
Symposium WebResponse – Agent.

8 On the agent’s PC, map the database machine and Nortel
folder as a virtual drive. See Windows online help for
instructions on mapping drives.

9 Click the Start  button  on the Windows taskbar and
click Run .

10 In the Open box, type (including the quotation marks) "f:\
Agent\Agent installer\setup"  where f: is the mapped drive
and then click OK.

11 On the Welcome window, click Next .

12 On the Choose Destination Location window, confirm the
destination folder and click Next .

13 On the Setup Type window, choose one of the setup options,
Typical,  Compact,  or Custom , then click Next to allow the
installation to proceed.

14 Wait for a message to appear that installation is complete.
Click Finish .

15 Check the Windows Program menu to see that Symposium
WebResponse – Agent has been installed in the Nortel
Program group.

16 Refer to Chapter 3, “Configuring Symposium WebResponse
Server” and then the online help for instructions on logging in
and adding users and skillsets.
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Uninstalling Symposium WebResponse Server

Introduction To remove Symposium WebResponse Server, you can use the
Uninstall programs available in the Control Panel. The uninstall
will not remove the Sybase database.

To uninstall Symposium
WebResponse –
Administration

1 From the Control panel, double-click the Add/Remove
Programs  icon.

2 On the Install/Uninstall property page, from the list of
installed software click Symposium WebResponse Admin .

3 Click Add/Remove… .

4 Click Yes to confirm deletion.

5 Click No to any question(s) prompting you to Remove
Shared Files or Services. (Leave shared files on the
computer.)

6 Click OK to exit from the Install/Uninstall property page.

7 Click OK.

To uninstall Symposium
WebResponse – Agent

1 From the Control panel, double-click the Add/Remove
Program  icon.

2 On the Install/Uninstall property page, from the list of
installed software, click Symposium WebResponse Agent .

3 Click Add/Remove… .

4 Click Yes to confirm deletion.

5 Click No to questions prompting your to Removed Shared
Files or Services. (Leave shared files on the computer.)

6 Click OK to exit from the Install/Uninstall property page.

7 Click OK.
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Chapter 3 Configuring Symposium
WebResponse Server

In this chapter

Overview..................................................................................................30
Logging in to Symposium WebResponse – Administration ....................31
Accessing online help and online tutorials ..............................................32
Creating database labels.........................................................................33
Adding skillsets........................................................................................34
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Overview

Introduction Once you have installed the Symposium WebResponse Server
and have installed Symposium WebResponse – Agent on one
agent PC, you are ready to configure Symposium WebResponse
Server using the Administration component.

Main configuration
procedures

These are the main configuration procedures. Each procedure is
described in detail later in this chapter.

� Log in to Administration to start configuration.

 Note:  After logging in and before continuing with these
procedures, review the online tutorials for Symposium
WebResponse – Administration.

� Create labels for the database fields so that you can generate
the web form

� Create skillsets so that you can define agent profiles.

For information on how to change these settings as well as how
to add and configure users, refer to the online help.
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Logging in to Symposium WebResponse – Administration

Introduction To access online help and online tutorials you must first log in
to Symposium WebResponse – Administration.

To log in to Symposium
WebResponse –
Administration

1 Click the Start  button  on the Windows taskbar and
select Programs>Nortel>Symposium WebResponse
Admin> Symposium WebResponse Admin .

2 In the Symposium WebResponse Agent login window, in the
User ID box, type sysadmin . This is your system
administrator user ID.

3 In the Password box, type nortel . This is your default system
administrator password.

4 In the Access Class box, select Administrator .

5 Click OK. The Symposium WebResponse – Administration
window appears.
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Accessing online help and online tutorials

Introduction Once you log in to either Symposium WebResponse –
Administration or Symposium WebResponse – Agent, you have
access to two types of help:

� online help

� online tutorials

 Online help provides both reference and procedural information
for the windows, boxes and buttons in the application as well as
step-by-step instructions on how to perform various procedures.

 Online tutorials supply a new user with sample situations and
visually demonstrate how to accomplish many tasks using the
software. Online tutorials are modular, allowing a user to view
small chunks of information in a session and then practice their
new skills.

 To access online help  To access online help, you can do one of the following:

� From the Help menu in Symposium WebResponse –
Administration, click Help Topics . The Help Contents Tab
appears. You can select any book or page.

 or

� From any window, click the Help  button or Help icon.

 An index of help topics appears.

 To access online tutorials  To access online tutorials:

� From the Help menu in Symposium WebResponse Server,
click Tutorials .

A list of tutorials appears. Double-click any tutorial topic.
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Creating database labels

Introduction Before you can begin to add users or generate the web form to
be used by customers, you must define the labels that appear in
the WebResponse Server database. This process sets up the
database labels that appear in the Symposium WebResponse –
Agent windows and also affects the web form you generate for
your customers to complete.

To get started using Symposium WebResponse Server without
defining the database labels, you can simply open the Label
Administration window and accept the defaults that are set by
the system. You can then change the labels after you have
looked at the system and determined your site’s requirements.

To create database labels Once installation is complete and you have restarted your server,
follow these steps to create database labels:

1 While logged on to the Administrator program, click the plus
sign (+) beside Symposium WebResponse Server.

2 Click the plus sign (+) beside Database Administration.

3 Double-click Labels .

4 Click Exit .

This generates the default labels or field names for all fields in
the Symposium WebResponse Server database. You can change
these labels once you determine how you would like them to
appear on your agents’ screens and on your web site.
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Adding skillsets

Overview You add skillsets to the database before you generate the web
form. A skillset  identifies the type of information requested by
the customer on the web form. All requests to the web form are
sorted by skillset.

When you add agents to the database, you will assign each agent
to one or more skillset. The process of customers categorizing
their request by skillset and agents being assigned to certain
skillsets means that transactions are sorted and assigned to
agents with the appropriate skillset.

To add skillsets Once installation is complete and you have restarted your server
and created your database labels, follow these steps to add agent
skillsets.

1 While logged on to the Administrator program, click the plus
sign (+) beside Symposium WebResponse Server.

2 Click the plus sign (+) beside System Administration.

3 Double-click Skillsets .

4 Click the Add  button.

5 In the Name box, type the name of the skillset you wish to
add (for example, Hardware).

6 In the Web description box, type the skillset description that
customers will see and choose when completing the Web
form (for example, Hardware problem).

Note:  You can change the skillsets you create, and you can
edit the Description field.

7 Click Exit  when you finish adding your skillsets.

8 To log off Symposium WebResponse – Administration, from
the File menu, click Exit .
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Chapter 4 Symposium WebResponse Server
database

In this chapter

Database tables ......................................................................................36
Tables and fields .....................................................................................37
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Database tables

Overview A Sybase database forms the heart of Symposium WebResponse
Server. All data relating to transactions, agents, responses, and
customers is stored in the database and updated appropriately.
The name for the WebResponse Server database is IRMSRV .

Using Symposium WebResponse Server’s data exchange
feature, you may wish to move information from the Symposium
WebResponse Server database to other legacy databases. As
well, using Crystal Reports, you can create custom reports using
the data stored in the database.

List of tables Listed below are the 12 tables that form the Symposium
WebResponse Server database.

� user_details table, which contains the profile for every
administrator, supervisor and agent

� site_details table, which contains information about the site
where Symposium WebResponse Server is installed

� trans table, which contains information about all open and
pending transactions, including transactions received on the
Web form

� history_trans table, which contains all closed transactions
and their responses. Fields in this table match those in the
trans table

� response table, which contains every response to a given
transaction including a date and time stamp and agent ID

� history_response table, which contains all closed responses.
Fields in this table match those in the response table

� customer table, which contains a unique ID and customer
information for those customers who are added to the
database

� label table, which contains a list of text strings for all fields
that appear in the user interface

� skillset table, which contains a profile of each skillset

� agent_skillset_mapping table, which contains list of which
agents are assigned to which skillsets

� skillset_statistics table, which contains the list of current
statistics and their thresholds

� call_barring table, which contains a list of all customers
who have been barred
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Tables and fields

Overview Using the Symposium WebResponse Server data exchange
function, you can share data between the Symposium
WebResponse Server database and another database (for
example, your customer information database). To do this type
of sharing, you need to know the fields in the Symposium Web
Server database so that you can link them. The tables and their
fields are listed below.

Table Field

agent_skillset_mapping
Name Type

agent_id numeric(12)

agent_skillset_mapping numeric(12)

display_enabled int

skillset_id numeric(12)

call_barring
Name Type

b_agent_id numeric(12)

b_alt_contact varchar(50)

b_caller_id numeric(12)

b_contract_code varchar(50)

b_cust_fax_Intl varchar(50)

b_cust_fax_na varchar(50)

b_cust_name varchar(40)

b_cust_phone_intl varchar(50)

b_cust_phone_na varchar(50)

b_customer_id numeric(12)

b_e_mail varchar(50)

b_expiry_date datetime

b_internet_phone_id varchar(50)

b_site_id varchar(50)

customer
Name Type

alt_contact varchar(50)

contact_name varchar(50)

contract_code varchar(50)
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cust_address1 varchar(50)

cust_address2 varchar(50)

cust_address3 varchar(50)

cust_address4 varchar(50)

cust_address5 varchar(50)

cust_classification archar(50)

cust_email varchar(50)

cust_fax_intl varchar(50)

cust_fax_na varchar(50)

cust_internet_phone_id varchar(50)

cust_name varchar(50)

cust_phone_intl vrchar(50)

cust_phone_na varchar(50)

cust_postal_zip_code varchar(50)

customer_id numeric(12)

site_id varchar(50)

history_response
Name Type

h_agent_comment varchar(200)

h_agent_id numeric(12)

h_attachment_location varchar(100)

h_callback_status varchar(50)

h_email_template_location varchar(100)

h_fax_template_location varchar(100)

h_history_response_id numeric(12)

h_number_used varchar(20)

h_resp_free_field1 varchar(100)

h_resp_free_field2 varchar(100)

h_resp_free_field3 varchar(100)

h_resp_free_field4 varchar(100)

h_resp_free_field5 varchar(100)

h_resp_free_field6 varchar(100)

h_response_attempt_no int

h_response_date datetime

h_response_method varchar(20)

h_response_number numeric(12)

h_response_text varchar(200)
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h_response_text2 varchar(250)

h_response_time datetime

h_time_allocated numeric(12)

h_transaction_no numeric(12)

history_trans
Name Type

h_agent_id numeric(12)

h_alt_contact varchar(50)

h_arrival_time datetime

h_callback_date datetime

h_callback_time varchar(50)

h_contact_method varchar(20)

h_contract_no varchar(50)

h_customer_id numeric(12)

h_free_field1 varchar(100)

h_free_field10 varchar(100)

h_free_field11 varchar(100)

h_free_field12 varchar(100)

h_free_field13 varchar(100)

h_free_field14 varchar(100)

h_free_field15 varchar(100)

h_free_field16 varchar(100)

h_free_field17 varchar(100)

h_free_field18 varchar(100)

h_free_field19 varchar(100)

h_free_field2 varchar(100)

h_free_field20 varchar(100)

h_free_field3 varchar(100)

h_free_field4 varchar(100)

h_free_field5 varchar(100)

h_free_field6 varchar(100)

h_free_field7 varchar(100)

h_free_field8 varchar(100)

h_free_field9 varchar(100)

h_internet_phone_id varchar(50)

h_objective text

h_pref_callback_media varchar(50)
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h_pref_intl_type varchar(20)

h_prev_contact varchar(50)

h_skillset_id numeric(12)

h_trans_address1 varchar(50)

h_trans_address2 varchar(50)

h_trans_address3 varchar(50)

h_trans_address4 varchar(50)

h_trans_address5 varchar(50)

h_trans_cust_name varchar(40)

h_trans_e_mail varchar(50)

h_trans_fax_intl varchar(50)

h_trans_fax_na varchar(50)

h_trans_phone_intl varchar(50)

h_trans_phone_na varchar(50)

h_trans_source varchar(20)

h_trans_status varchar(20)

h_trans_timestamp timestamp

h_trans_type varchar(40)

h_transaction_no numeric(12)

history_no numeric(12)

label
Name Type

agent_dn varchar(50)

agent_fax varchar(50)

agent_id varchar(50)

agent_name varchar(50)

agent_pass varchar(50)

agent_status varchar(50)

alt_contact varchar(50)

arrival_time varchar(50)

callback_date varchar(50)

comm_contact_name varchar(50)

comm_cust_name varchar(50)

comm_email varchar(50)

comm_email_temp varchar(50)

comm_fax_intl varchar(50)

comm_fax_na varchar(50)
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comm_fax_temp varchar(50)

comm_free_field1 varchar(50)

comm_free_field2 varchar(50)

comm_free_field3 varchar(50)

comm_free_field4 varchar(50)

comm_free_field5 varchar(50)

comm_free_field6 varchar(50)

comm_phone_intl varchar(50)

comm_phone_na varchar(50)

comm_pref_intl varchar(50)

comm_pref_media varchar(50)

comm_resp_id varchar(50)

comm_trans_id varchar(50)

contract_no varchar(50)

cust_address1 varchar(50)

cust_address2 varchar(50)

cust_address3 varchar(50)

cust_address4 varchar(50)

cust_address5 varchar(50)

cust_alt_contact varchar(50)

cust_classification varchar(50)

cust_contact_name varchar(50)

cust_contract_code varchar(50)

cust_email varchar(50)

cust_fax_intl varchar(50)

cust_fax_na varchar(50)

cust_free_field1 varchar(50)

cust_free_field2 varchar(50)

cust_free_field3 varchar(50)

cust_phone_intl varchar(50)

cust_phone_na varchar(50)

cust_postal_zip_code varchar(50)

cust_search varchar(50)

cust_site_id varchar(50)

customer_id varchar(50)

free_field1 varchar(50)

free_field10 varchar(50)

free_field11 varchar(50)
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free_field12 varchar(50)

free_field13 varchar(50)

free_field14 varchar(50)

free_field15 varchar(50)

free_field16 varchar(50)

free_field17 varchar(50)

free_field18 varchar(50)

free_field19 varchar(50)

free_field2 varchar(50)

free_field20 varchar(50)

free_field3 varchar(50)

free_field4 varchar(50)

free_field5 varchar(50)

free_field6 varchar(50)

free_field7 varchar(50)

free_field8 varchar(50)

free_field9 varchar(50)

get_tran_id varchar(50)

get_tran_status varchar(50)

internet_phone_id varchar(50)

label_profile numeric(12)

objective varchar(50)

pref_callback_media varchar(50)

pref_intl_type varchar(50)

prev_contact varchar(50)

resp_agent varchar(50)

resp_agent_comment varchar(50)

resp_attachment_location varchar(50)

resp_attempt_no varchar(50)

resp_callback_status varchar(50)

resp_date varchar(50)

resp_free_field1 varchar(50)

resp_free_field2 varchar(50)

resp_free_field3 varchar(50)

resp_free_field4 varchar(50)

resp_free_field5 varchar(50)

resp_free_field6 varchar(50)

resp_method varchar(50)
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resp_number varchar(50)

resp_number_used varchar(50)

resp_query_num varchar(50)

resp_template varchar(50)

resp_text varchar(50)

resp_time varchar(50)

resp_time_worked varchar(50)

resp_tran_id varchar(50)

skillset_id varchar(50)

trans_address1 varchar(50)

trans_address2 varchar(50)

trans_address3 varchar(50)

trans_address4 varchar(50)

trans_address5 varchar(50)

trans_callback_heading varchar(50)

trans_callback_time varchar(50)

trans_cookie_id varchar(50)

trans_cust_name varchar(50)

trans_e_mail varchar(50)

trans_email_radio varchar(50)

trans_fax_intl varchar(50)

trans_fax_na varchar(50)

trans_fax_radio varchar(50)

trans_intl_radio varchar(50)

trans_location_heading varchar(50)

trans_na_radio varchar(50)

trans_owner varchar(50)

trans_phone_intl varchar(50)

trans_phone_na varchar(50)

trans_source varchar(50)

trans_status varchar(50)

trans_tcpip_address varchar(50)

trans_telephone_radio varchar(50)

trans_timestamp varchar(50)

trans_type varchar(50)

transaction_no varchar(50)

response
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Name Type

agent_comment varchar(200)

agent_id numeric(12)

attachment_location varchar(100)

callback_media varchar(20)

callback_status varchar(50)

email_template_location varchar(100)

fax_template_location varchar(100)

number_used varchar(20)

resp_free_field1 varchar(50)

resp_free_field2 varchar(50)

resp_free_field3 varchar(50)

resp_free_field4 varchar(50)

resp_free_field5 varchar(50)

resp_free_field6 varchar(50)

resp_free_field7 varchar(50)

resp_free_field8 varchar(50)

response_attempt_no int

response_date datetime

response_method varchar(20)

response_number numeric(12)

response_text varchar(200)

response_text2 text

time_allocated numeric(6)

transaction_no numeric(12)

site_details
Name Type

admin_pass varchar(10)

company_name varchar(20)

current_logged_on int

features_enabled int

max_no_clients int

site_id varchar(10)

skillset
Name Type

parent_skillset_id numeric(12)

skillset_id numeric(12)
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skillset_name varchar(50)

skillset_threshold numeric(5)

web_description varchar(50)

skillset_statistics
Name Type

agents_available_threshold int

agents_available_value int

agents_in_service_threshold int

agents_in_service_value int

average_handle_time_threshold int

average_handle_time_value int

longest_waiting_time_threshold int

longest_waiting_time_value int

new_calls_waiting_threshold int

new_calls_waiting_value int

open_calls_waiting_threshold int

open_calls_waiting_value int

pending_calls_waiting_threshol int

pending_calls_waiting_value int

skillset_id numeric(12)

trans
Name Type

agent_id numeric(12)

alt_contact varchar(50)

arrival_time datetime

callback_date datetime

contract_no varchar(50)

customer_id numeric(12)

free_field1 varchar(100)

free_field10 varchar(100)

free_field11 varchar(100)

free_field12 varchar(100)

free_field13 varchar(100)

free_field14 varchar(100)

free_field15 varchar(100)

free_field16 varchar(100)

free_field17 varchar(100)
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free_field18 varchar(100)

free_field19 varchar(100)

free_field2 varchar(100)

free_field20 varchar(100)

free_field3 varchar(100)

free_field4 varchar(100)

free_field5 varchar(100)

free_field6 varchar(100)

free_field7 varchar(100)

free_field8 varchar(100)

free_field9 varchar(100)

internet_phone_id varchar(50)

objective text

open_duration numeric(18)

open_time datetime

pref_callback_media varchar(50)

pref_intl_type varchar(20)

prev_contact varchar(50)

skillset_id numeric(12)

trans_address1 varchar(50)

trans_address2 varchar(50)

trans_address3 varchar(50)

trans_address4 varchar(50)

trans_address5 varchar(50)

trans_callback_time varchar(50)

trans_cust_name varchar(40)

trans_e_mail varchar(50)

trans_fax_intl varchar(50)

trans_fax_na varchar(50)

trans_phone_intl varchar(50)

trans_phone_na varchar(50)
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Chapter 5 Database integration

In this chapter

DDE messages .......................................................................................48
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DDE messages

Overview Symposium WebResponse – Agent allows you to integrate
external database applications and softphone utilities (such as
Fastview). This integration is done by using Dynamic Data
Exchange (DDE), a feature of the Windows platform.

For instance, your external application can take the customer’s
name from the agent’s screen and use it to search your own
database for further details about the customer. You can display
the database details in a separate window.

Likewise, SWRS uses DDE to pass a telephone number to a
softphone application.

This chapter provides reference information that will allow
database integrators to capture the data sent from the agent’s
desktop.

Dynamic Data Exchange
roles

The Symposium WebResponse – Agent is a DDE client. The
external database application is the DDE server.

When an agent clicks the Communicate Customer Info 
button, Symposium WebResponse – Agent initiates a DDE
conversation. The application sends the value in the Customer
Name field (customer.cust_name) to the DDE server.

An external application can use the Customer Name to search its
own database for details about the customer, and present
additional information to the agent in a separate window.
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To customize IRMCLIENT.INI
for DDE use

On the Agent client machine, the name of the DDE server is
stored in C:\Windows\IRMCLIENT.INI or
C:\Winnt\IRMCLIENT.INI. Although you can edit each file
individually, it is more efficient to edit and test the master
version of the INI file before doing each Symposium
WebResponse – Agent setup.

Here is an excerpt from the default initialization file, followed
by an explanation of the DDE parameters:

[Customer DDE Link]
CustLinkTopic=Source|Form1
CustLinkItem=Text1
[Transaction DDE Link]
TransLinkTopic=Source|Form1
TransLinkItem=Text2
[SoftPhone DDE Link]
SoftPhoneApplication=C:\Fastview\bin\Jit_mast
SoftPhoneLinkTopic=CallServ|MakeCall

[Customer DDE Link] – Points the client to the area of the
INI file that contains the parameters for the DDE link for
customer details. This line is used internally within SWRS and
must not change.

CustLinkTopic=Source|Form1 – Source is the name of the
server application, for example, Excel. Form1 (after the pipe
symbol) is the name of the link topic, in this case a Visual Basic
form. You must replace Source and Form1 to reflect your link
topic.

CustLinkItem=Text1 – Text1 is the name of the control (for
example, a text box) that is the item of the DDE conversation.
You must replace Text1 with the name of your link item.

[Transaction DDE Link] – Points the client to the area of
the INI file that contains the parameters for the DDE link that
takes place when the transaction is closed. Do not change this
line as it is used internally by Symposium WebResponse Server.

TransLinkTopic=Source|Form1 – Source is the name of
the server application (for example, Excel). Form1 (after the
pipe symbol) is the name of the link topic, in this case a Visual
Basic form. You must replace Source and Form1 to reflect your
link topic.

TransLinkItem=Text2 – Text2 is the name of the control
(for example, a text box) that is the item of the DDE
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conversation. This item receives the Transaction ID when the
SWRS transaction is closed. You must replace Text2 with the
name of your link item.

[SoftPhone DDE Link] – Points Symposium WebResponse
Server to the area of the INI file that contains the parameters for
the DDE link for the softphone utility such as FastView. This
line is used internally within Symposium WebResponse Server
and must not change.

SoftPhoneApplication=C:\Fastview\bin\jit_mast –
Identifies the location and filename of the softphone utility that
Symposium WebResponse Server should launch.

SoftPhoneLinkTopic=CallServ|MakeCall – Callserv
specifies the name of the DDE server application. MakeCall
specifies the link item in the softphone application's that
receives the telephone number to dial.
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Appendix A   Troubleshooting

Introduction This appendix provides information about possible error
conditions that may occur during installation of Symposium
WebResponse Server and how to respond to them.

Problem 1:
Removing an incomplete
database installation

I had hardware problems while installing the SWRS database
and had to stop the setup. How do I remove the database and
start the installation over?

If you started to install the Symposium WebResponse Server
database but didn’t finish the installation, you should delete
whatever was installed and then start database setup again.
Usually, you don’t need to remove the entire Sybase application.
The following instructions explain how to delete the incomplete
database installation.

To delete the database You can delete the Symposium WebResponse Server database
using Sybase SQL Advantage.

1 Using the Services utility (Settings>Control Panel>Services),
stop the SWRSRTServer and SWRS_CGI services if they
are running.

2 Open Sybase Central and run the SQL Advantage utility.

3 In SQL Advantage, from the Server menu, click Connect .

4 Connect to the server IRMSRV using the login name admin
and the password adminpwd .

5 In the Session text area, type the following command. Then,
from the Query menu, click Execute Query :

use master

Caution – Risk of data loss

The following step will destroy data. The data cannot be
recovered.

6 In the Session text area, type the following command. Then,
from the Query menu, click Execute Query :

drop database IRM_LITE
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To restore the default
administration account

Before attempting another installation, you must reset the
administration account to the default (sa).

1 Type the following command and execute the query:

sp_locklogin sa,unlock

2 Type the following command and execute the query:

sp_role "grant", sso_role,sa

To remove all logins The installation program may have set up default logins that
need to be removed.

1 Remove all Symposium WebResponse Server logins. Type
the following commands in SQL Advantage and execute the
query:

sp_droplogin integrator
go
sp_droplogin webinsert
go
sp_droplogin supervisor
go

2 Disconnect from the server by clicking Server>Disconnect .

3 Connect to the server and login to IRMSRV using the sa
account with no password.

4 Delete the remaining logins by typing the following
commands, and execute the query:

sp_droplogin admin
go
sp_droplogin rtdisplay
go
sp_droplogin agent
go

5 Delete the SWRS database devices by typing the following
commands, and execute the query:

sp_dropdevice logdev
go
sp_dropdevice datadev
go

6 Exit SQL Advantage.
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To shut down the SQL
server

Before you can gain permission to remove a database file from
your hard disk drive, you need to shut down the SQL server.

1 In Sybase Central, click IRMSRV.

2 If necessary, log in using the login ID sa with no password.

3 From the File menu, click Stop .

4 If necessary, confirm that you want to stop the installation.

5 Exit Sybase Central.

To delete the database files The last step is to actually delete the database files from your
hard disk drive.

� With the databases shut down, delete the following files in
the directories (for example c:\Sybase\data\) that you
specified during setup:

SWRS_datadev.dat
SWRS_logdev.dat
and associated backup files

Problem 2:
Run doesn't launch some
setup routines

Some of the setup programs failed to launch when I used the,
Start button and Run dialog box even though I typed the text
correctly in the Open box. I had to browse to run the setup files.

Make sure that you have typed a double quotation mark (")
before and after the drive:\path\filename text. Some folder
names include spaces and therefore must be wrapped in
quotation marks.

Problem 3:
The web form is nearly empty

I ran the HTML Generator but the form fields are missing in the
HTML file.

Make sure that you run the Labels utility before trying to
generate HTML or Java code. The Labels utility sets up the
default database labels.
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